# Contents

## Reference Guide Conventions

- What You Need to Know Before Using This Reference Guide
- Visual Aids Used in This Reference Guide

## Overview

- Protocol Setup Process
- Getting Help
  - CTMS Learning Center
  - CTMS Support
- Terminology
- Logging in to the CTMS
  - Compatible with Multiple Browsers
  - Logging In
- User Access
- User Access
- User Preferences
  - Completing Your Profile
  - Customizing the Layout of the Tabs
- Saving Changes in the CTMS
- Logging Out of the CTMS

## Navigating Within the CTMS

- CTMS Home Tab
- Other CTMS Pages
- Screen Tabs
- Site Map
- Navigation Tips
<table>
<thead>
<tr>
<th>Query Basics ................................................................. 25</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Search Box to Run a Query .................................. 25</td>
</tr>
<tr>
<td>Running a Query .......................................................... 25</td>
</tr>
<tr>
<td>Using the Query Assistant ................................................ 26</td>
</tr>
<tr>
<td>Searching for Multiple Criteria in One Field ....................... 27</td>
</tr>
<tr>
<td>Refining a Query .......................................................... 28</td>
</tr>
<tr>
<td>Saving a Query ............................................................ 28</td>
</tr>
<tr>
<td>Running a Saved Query ................................................... 29</td>
</tr>
<tr>
<td>Deleting a Saved Query .................................................. 29</td>
</tr>
<tr>
<td>Query Tips ..................................................................... 30</td>
</tr>
<tr>
<td>Query Operators ................................................................ 30</td>
</tr>
<tr>
<td>Operator Scenarios and Examples ....................................... 31</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Running Reports and Exporting Data ................................. 33</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard CTMS Reports .................................................... 33</td>
</tr>
<tr>
<td>Running a Report ................................................................ 33</td>
</tr>
<tr>
<td>Returning to CTMS after Running a Report ............................. 36</td>
</tr>
<tr>
<td>Exporting Data to Microsoft Excel ....................................... 37</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Appendix A: Enable Pop-up Windows in Chrome .......... 39</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing Chrome’s Pop-Up Blocker Setting ............................ 39</td>
</tr>
</tbody>
</table>

| Appendix B: CTMS Access Form ....................................... 41 |
What You Need to Know Before Using This Reference Guide

To gain maximum benefit from the material presented in this reference guide and the associated training course, you should have a working knowledge of personal computers (PCs), Microsoft Windows, and the DCRI network. If you need training in any of these areas, send an email message to IT Training (at dcriittraim@dm.duke.edu) requesting assistance.

Visual Aids Used in This Reference Guide

This reference guide uses the following visual aids to indicate notes, tips, and warnings.

**Note**: The note icon indicates a clarification or supplemental information. Content that is too extensive for a note appears inside a shaded box instead. Read a note or a shaded box if you want to learn more about a particular step or procedure.

**Tip**: The tip icon indicates a helpful hint or keyboard shortcut. Read a tip if you want to learn a quicker or easier way to perform a particular step or procedure.

**Warning**: The warning icon indicates that performing a particular step or procedure under the stated conditions causes a significant problem or concern. Always read warnings.
OVERVIEW

DCRI’s Clinical Trial Management System (CTMS) serves as a central data repository for storing and managing trial management and site information. The application, Siebel eClinical (Oracle), has been customized to accommodate DCRI-specific needs, and enables you to:

♦ Maintain contact information for each site in the protocol, including the roles of site personnel.
♦ Track each site’s progress through the course of the protocol.
♦ Track the status of all essential documents that each site must submit to participate in the protocol, thereby ensuring that each site complies with FDA regulations and sponsor requirements.
♦ Log correspondence with sites as the protocol progresses.
♦ Run reports on information collected in the CTMS.
♦ Track site visits and generate Trip Reports that are submitted to sponsors, capturing detailed monitoring activities.
♦ Review and/or maintain enrollment data for each site.

To gain access to the CTMS:

♦ You must attend the appropriate CTMS classes:
  – *CTMS Fundamentals* (required for all CTMS users)
  – *CTMS Site Management* or *CTMS Site Monitoring*, or both (depending on your role)
♦ Your supervisor (i.e., your Lead) must submit a *CTMS Access Form* (see “Appendix B: CTMS Access Form” on page 41).
Protocol Setup Process

All projects requiring DCRI site management or site monitoring services must be tracked in the CTMS. Before a new protocol is entered into the CTMS, a Protocol Setup meeting occurs, including the PL (Project Lead), Lead CRA (Clinical Research Associate), or other project designee, and a DCRI CTMS Business Support representative. In the meeting, members complete a Protocol Setup Requirements Form. Once the requirements have been finalized, the DCRI CTMS Business Support group configures, tests, and releases the protocol into the CTMS.

Other protocol setup considerations include:

- **Data Entry Guideline** (DEG)—Protocol-specific outline of how data should be entered into the CTMS.

- **Activity Plan(s)**—Pre-defined, protocol specific list(s) of activities (e.g., milestones, documents, training events) that will be required for all sites. Activity Plans are defined by the PL or Lead CRA and are entered into the CTMS by a CTMS Administrator. A sample Activity Plan is provided prior to the Protocol Setup meeting.

- **Site Management options**—Examples include whether contracts will be tracked, whether protocol deviations will be tracked at the site level (if not using the CTMS Trip Report feature), and/or design of custom queries for the protocol team.

- **Site Monitoring options**—Examples include the addition of protocol-specific checklist items, design of custom Confirmation and Follow-Up letters, and/or whether the protocol requires blinding/unblinding of monitoring visits.

- **System integrations**—The CTMS can be programmed to communicate with other DCRI systems as needed per protocol.

- **Non-DCRI personnel system access**—Limited and/or read-only access to CTMS data can be provided to external users.

- **Reporting**—Custom reports can be designed to meet your protocol’s needs. Additional costs may be incurred.
Getting Help

It is a good idea to always check first with your protocol team members to resolve any CTMS-related questions or issues, as they may have knowledgeable answers that are specific to your protocol.

CTMS Learning Center

Information and resources are available on the CTMS Learning Center. Go to dcri.org, click Education/Training, and then click CTMS Learning Center. The direct URL is https://dcri.org/education-training/ctms-learning-center. Here you will find:

♦ CTMS training documentation and web-based training solutions
♦ Important CTMS forms and instructions
♦ CTMS Super User support details
♦ Templates and other helpful resources

CTMS Support

All CTMS requests for support should be directed to the DCRI Service Desk by phone (919.668.8916) or by email (dcriservicedesk@dm.duke.edu) Monday through Friday, 7 a.m. to 6 p.m., US Eastern time. For help outside normal operating hours, leave a voice message that includes your name, where and how you can be contacted, and a brief description of your problem. Your request will be forwarded to a CTMS support representative.

For further general assistance, or to submit comments on IT Training’s CTMS classes, training modules, or documentation, email IT Training at dcriittrain@dcri.duke.edu.

Terminology

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Facility, IRB, Other</td>
</tr>
<tr>
<td>Contact</td>
<td>Trial-related personnel</td>
</tr>
<tr>
<td>Program</td>
<td>Therapeutic Area</td>
</tr>
<tr>
<td>Protocol</td>
<td>Trial</td>
</tr>
<tr>
<td>Site or Protocol Site</td>
<td>Unique combination of Protocol + Account + PI</td>
</tr>
<tr>
<td>Subject</td>
<td>Patient</td>
</tr>
</tbody>
</table>
Logging in to the CTMS

The same login procedures apply whether you are logging in to the CTMS from within the DCRI network or remotely. To access the CTMS remotely, you simply need to have an Internet connection. It is not necessary for you to be logged in to the DCRI network.

Which Browser to Use

♦ Microsoft Internet Explorer (version 11) is now the preferred and fully-supported browser for CTMS. DO NOT USE Internet Explorer below version 11, as it is no longer supported by the CTMS manufacturer, Siebel RM Systems, Inc.

♦ You can still use Google Chrome, Mozilla Firefox, or Apple Safari to access the CTMS, but keep in mind that some features and functionality vary based on the browser. If you experience a problem with a function, consider using Internet Explorer.

Logging In

1 In the browser’s address bar, enter http://ctms.dcri.duke.edu and then press Enter.

The CTMS login page appears.

2 In the User ID field, enter your current DCRI network ID.

3 In the Password field, enter your current DCRI network password.

4 Click LOGIN.

The CTMS Home screen tab appears.
You are finished with this procedure.

**WARNING:** When creating a new DCRI network password, do not use special characters (i.e., ",", ",\"), as they could interfere with CTMS functionality.

**NOTE:** When you change your DCRI network password, your CTMS password is automatically synchronized. However, you might have to wait 5-15 minutes before you can use your new password in the CTMS. If you need to access the CTMS before your new password is active, use your old password.

**TIP:** You can adjust the view by zooming in or out. To zoom in, press Ctrl + + (plus sign in upper right of keyboard). To zoom out, press Ctrl + - (minus sign in upper right of keyboard).
User Access

CTMS users are assigned roles that define their job responsibilities and the corresponding data they can access.

The following roles are defined in the CTMS:

♦ Assistant Director
♦ Clinical Data Integration
♦ Clinical Trial Assistant (CTA)
♦ Clinical Trial Manager
♦ CRA Non-Traveling
♦ CRA Traveling
♦ Lead CRA
♦ Project Lead Assistant
♦ Project Leader
♦ Project Office
♦ Site Start Up Specialist

System administrators define these roles and determine what users can access. Therefore, the tabs you see after you log in to the CTMS might differ from the tabs other users in your trial team see.

For information on requesting access to the CTMS, see “Appendix B: CTMS Access Form” on page 41.
User Preferences

Go to the User Preferences screen to complete your profile, such as your phone number and email address, and to change the order in which screen tabs appear on your CTMS screens. Changes that you make will affect your account only.

Completing Your Profile

1. Click the User Preferences screen tab.

   The User Profile window opens. Note: If necessary, click the Profile screen link (in the blue banner).

2. Complete the fields you want, and then either click the Save icon ( сохранить ) in the upper right (the screen toolbar) or press Ctrl+S.
Customizing the Layout of the Tabs

1. Click the User Preferences screen tab.

2. Click Tab Layout.

3. Do one of the following:
   - To change the order the screen tabs appear in your CTMS window:
     a. Click in the Order field for the screen tab you want to appear first. Then enter 1.
     b. Click in the Order field for the screen tab you want to appear second. Then enter 2.
     c. Continue changing the numbers in the Order column until each screen tab has the appropriate order number.
     d. Log out of the CTMS and then log back in to see your changes.

   Or

   - To change the order that view tabs appear on a particular screen tab:
     a. Click on a screen tab row to select it.
     b. Scroll down to the View Tab Layout area to view the current view tab layout for the selected screen tab.
     c. Click in the Order field for the view tab you want to appear first. Then enter 1.
d Click in the **Order** field for the view tab you want to appear second. Then enter 2.

e Continue changing the numbers in the **Order** column until each view tab has the appropriate order number.

f Log out of the CTMS and then log back in to see your changes.

## Saving Changes in the CTMS

To save any changes while working in the CTMS, do one of the following:

- Press **Ctrl+S**. With this method you can be assured that your edits are saved.

- Click in another area of the screen. This is referred to as “stepping off” the record. Please be aware that this method works 99% of the time, but there is a small chance for work to be lost with this option.

- Press **Enter**.

- Click the Save icon ( ), where available.

- Press **Tab** until you have completed the row.

## Logging Out of the CTMS

Do not close the browser window to log out of the CTMS, as this will leave the application running in the background and could pose a security risk. Instead, do one of the following:

- From the application-level menu bar, select **File>Log Out**.

  Or

- Press **Ctrl+Shift+X**.
NAVIGATING WITHIN THE CTMS

Since the CTMS is browser-based, getting from one screen to another is intuitive, especially after you become familiar with its basic navigation features.

CTMS Home Tab

When you first open the CTMS, the Home tab appears. The following picture shows some of the features of the Home tab. The table below the picture describes these features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application menu bar</td>
<td>Menus to perform actions within the application.</td>
</tr>
<tr>
<td>Application toolbar</td>
<td>Shortcuts to Execute Query and Site Map.</td>
</tr>
<tr>
<td>Screen tabs</td>
<td>Tabs to specific screens. The tab for the active screen is highlighted (Home in the example).</td>
</tr>
<tr>
<td>Screen links</td>
<td>Links associated with a specific screen tab. The example only has one link, Home.</td>
</tr>
<tr>
<td>Information panels</td>
<td>Blocks of information. The default ones are: My Alerts—Broadcast messages from CTMS Support.</td>
</tr>
</tbody>
</table>
Other CTMS Pages

The following picture shows the major navigation features of a CTMS page. The table that follows the picture describes these features and how to use them.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(continued)</td>
<td></td>
</tr>
<tr>
<td><strong>Helpful Links</strong></td>
<td>Links to reference guides and other literature.</td>
</tr>
<tr>
<td><strong>6 Months of My Outstanding Trip Reports</strong></td>
<td>Trip Reports from the last 6 months with the status of <em>Not Started, In Progress, orSubmitted.</em> This panel is populated only for users performing site monitoring activities.</td>
</tr>
<tr>
<td><strong>My Open Follow-ups</strong></td>
<td>All <em>Open</em> follow-up activities assigned to you. This panel is populated only for users performing site monitoring activities.</td>
</tr>
<tr>
<td>Note:</td>
<td>These last two panels offer expand (⁺) and collapse (⁻) views.</td>
</tr>
</tbody>
</table>

Navigating Within the CTMS

Rev. 11 - December 2016
### Screen Tabs

The table below defines some commonly accessed screen tabs. If you do not see a screen tab, use the Site Map to locate it (see “Site Map” on page 21). Your role determines which screen tabs that you see when you log on to the CTMS (see page 12).

<table>
<thead>
<tr>
<th>Screen Tab Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Home</strong></td>
<td>Customizable window that gives snapshot views of items you can access. Click the <strong>Edit Layout</strong> button to customize its views and layout.</td>
</tr>
<tr>
<td><strong>Contacts</strong></td>
<td>People related to the clinical research process. Typically, contacts are principal investigators, study coordinators, and other personnel who work at sites, such as sponsors and partners.</td>
</tr>
<tr>
<td>Screen Tab Name</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Accounts</td>
<td>Organizations or entities, such as sponsors, hospitals, clinics, vendors, partners, committees, labs, institutional review boards (IRB), or clinical research organizations (CRO).</td>
</tr>
<tr>
<td>Site Management</td>
<td>Sites for all protocols you can access. For each site, the view tabs at the bottom of the window enable you to work with site-specific details, such as site contacts and accounts, statuses and milestones, documents and training, and site visits.</td>
</tr>
<tr>
<td>Protocols</td>
<td>“Rolled-up” data, such as all site contacts for the protocols you can access.</td>
</tr>
<tr>
<td>Reports</td>
<td>Access to CTMS Standard Reports. For instructions on how to generate a report, see “Running Reports and Exporting Data” on page 33.</td>
</tr>
<tr>
<td>Regions</td>
<td>“Rolled-up” data, such as total number of planned sites and total number of enrolled subjects per region, for defined regions you can access.</td>
</tr>
<tr>
<td>User Preferences</td>
<td>User-specific profile details and view settings, enabling you to customize your CTMS window. For example, you can adjust the order screen tabs appear on the window. For more information on the User Preferences screen tab, see “User Preferences” on page 13.</td>
</tr>
<tr>
<td>Site Visits</td>
<td>Site visits for all protocols to which you have access. Provides “rolled-up” details, for example, showing all site visits across protocols. Also provides an alternative to the Site Management screen tab for locating site visit information. <strong>Note:</strong> This tab is not displayed by default. To display the tab, follow the “Customizing the Layout of Tabs” instructions on page 14.</td>
</tr>
</tbody>
</table>
Subjects

Subjects (patients) in the CTMS. Depending on your trial, the subject list might be imported automatically into the CTMS, or you may have to add subjects manually. If necessary, you can also indicate which subjects are to be monitored.

**Note:** This tab is not displayed by default. To display the tab, follow the “Customizing the Layout of Tabs” instructions on page 14.

---

**Site Map**

The CTMS Site Map is a textual index of the application’s screens and views. You can use the site map to navigate through the CTMS application.

To use the Site Map:

1. Click the **Site Map** button ( ) in the application toolbar. The Site Map window appears.
2. Click a hyperlink for the screen, view, or subview that you want to display.
Navigation Tips

Search box. Above every list of data, there is a Search box that enables you to quickly search for a record or filter the list. Select a category in the first field, enter search criteria in the second field, and then either click the button or press Enter on your keyboard. Or, you can click the Query button ( ) on the screen toolbar, click under a heading in the list, enter a value, and then press Enter.

Navigation buttons. Located under every list of data, navigation buttons allow you to move backward or forward by page, record, or record set.

Scroll bars. The scroll bar on the browser’s far right takes you up and down the entire page. However, there can be multiple left/right scroll bars on the page: one for the screen in the upper half and a different one for the view below.

Show more/Show less buttons. At any one time you can view up to ten records in a list of data. To view more records, go to the toolbar to click the Show More button (replaced by the Show Less button).

Lock columns. Click a column heading, and then click Lock. That column and all columns to the left remain “frozen” when you scroll to the right.

Column sorting. At any time, you can click a column heading to sort the window by that column. Changes that you make do not affect other CTMS users’ views.

Advanced sorting. To sort by more than one column, click the cog icon ( ) to select Advanced Sort (or press Ctrl+Shift+O). Select sort options for up to three columns, and then click OK.

Sizing columns. Point to the line between two column headings until your mouse pointer becomes a two-sided arrow ( ). Click and drag to resize the column width. These adjustments will stay even after you log out and back in.
Moving, hiding, and showing columns. You can move, hide, or show columns for any screen. These adjustments will stay even after you log out and back in.

- Drag columns to the right or left to rearrange them.
- On the screen links bar, select Menu>Columns Displayed to hide or show columns.

Browser Back button. You can use your browser’s Back button at any time to return to a previous screen or view.

Refreshing the view. If you have changed a value in a field, but the change is not displayed, refresh your view by clicking the Execute Query button ( ) in the application toolbar.

Escape (Esc) key. When you begin to add new data, you must either complete all required fields or press the Esc key to get out of edit mode (no changes will be saved).

- If you try to go to another location while you are still in edit mode, a message similar to the following appears.

Click OK, and then either complete all required fields or press Esc.

Type-ahead feature. To save time when entering data in a drop-down list field, enter the first few letters of an item in the list. When you press Tab, the CTMS will either automatically fill in the field (if there is only one match in the list) or will open the list with the first matching item highlighted.

Bread crumbs. At the top of the CTMS window, a hyperlink displays your current location. You can click the links to go to a previously-viewed screen or view.
QUERY BASICS

Queries enable you to search for and list only those records that meet certain criteria. For example, in the Site Management screen, you can run a query to show only sites located in a particular state.

Using the Search Box to Run a Query

Remember, above every list of data, there is a Search box (two fields and a button) that you can use to quickly locate a record or filter the list.

1. Open a screen containing a list of data.
   Above the list is the Search box.

2. In the first field, click the drop-down arrow to select a category you want the system to search in.

3. In the second field, enter search criteria.

   ![Search Box Example]

4. Either click the button, or press Enter on your keyboard.

   Tip: What you have as the first column in the list of data becomes the top option in the Search box drop-down list. Thus, if you change the default leftmost column by dragging a different column heading to the far left, that header becomes the top option in the Search box drop-down list.

Running a Query

1. Open a screen containing a list of data.

2. In the screen toolbar, click the Query button (Q).
   The table no longer contains data. An empty row appears under the column headers.
3 Click in the field under the column heading you want to query, and then enter the search criteria. You can enter criteria in multiple fields.

<table>
<thead>
<tr>
<th>Site #</th>
<th>PI First Name</th>
<th>Region</th>
<th>Protocol</th>
<th>PI Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>USA: Central</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Tip:** When entering criteria, you can use an asterisk (*) as a wildcard to represent missing characters. For example, to search for all last names that begin with Ma, enter Ma* in the **Last Name** field. See page 30 for more operators.

4 Either press **Enter** or click the Go button ( ) in the screen toolbar. The query returns a list of records that match your criteria.

**Tips:**
- If you ran a query and want to return to the entire list for that screen tab, click the screen tab again to view the default list of items.
- You can run a blank query by selecting **Query** and then **Go**.

### Using the Query Assistant

Some query windows also offer a **Query Assistant** button that provides help with creating a query.

1 Click the Query button in the screen toolbar.
   An empty row appears under the column headers.

2 Click the Query Assistant button ( ) in the screen toolbar.
   The Query Assistant dialog appears.
Create a query of up to four criteria items, using the drop-down lists to select query fields and conditions.

Example:
To search for a list of sites located in NC, SC, and VA:

a. Click the first drop-down list to select Prov/State.
b. Leave the second drop-down list with the default of Starts With.
c. Enter NC in the text field.
d. Repeat steps a–c, entering SC and VA in the next two text fields.
e. From the Perform Query using drop-down list, select OR.

Click Go.

The query returns a list of records matching your criteria.

Searching for Multiple Criteria in One Field

Since the Query Assistant is limited to four search items at a time, use the following procedure to search for more items in the same field.

1. Click Query.

2. In the blank row, click in the field you want to query. For example, to create a state query, click in the Prov/State field.

3. Enter the criteria items in quotes (single or double), separated by an operator, such as OR. For example, you enter 'NC' OR 'SC' OR 'VA' OR 'GA' OR 'FL' to search for more than four states.

4. Click the Go button ( ) in the screen toolbar.

The query returns a list of records matching your criteria. For more information about query operators, see page 30.
Refining a Query

Each time you run a query, by default the CTMS searches the entire database. To further define an existing query result list, use the refine query tool.

1. After running a query, either press Alt+G or click the cog icon (⚙️) in the screen toolbar to select **Refine Query**.

2. Enter search criteria into one or more fields.

3. Click the Go button (/go/) in the screen toolbar. The query searches only in the existing query result list and returns a list of records matching your criteria.

   **Note:** Refining a query does not save the new criteria to the original query. You must save the refined query with a new name and, if necessary, delete the original query.

Saving a Query

Commonly used queries can be saved so that they are available from the **Queries** drop-down list at any time. Saved queries are specific to the screen tab that you are viewing and to your account only. If you would like others to be able to use your saved query, submit a CTMSR form to “publish” your saved query. For more information about the CTMSR form, see “Appendix B: CTMS Request Form” in IT Training’s **CTMS Site Management Topics** user reference guide.

1. After you run a query, either press Alt+S or go to the application menu bar to select **Query>Save Query As**.

   The Save Query As window appears.
2 Enter a name for the query in the **Query Name** field.

**WARNING:** Entering an asterisk (*) and a space before the query name could result in that query appearing first in the list, therefore replacing the default *My Sites* query. This means that it will automatically run each time you return to the screen.

This dialog lists queries you saved in the past.

3 Click **OK**.

The query is saved.

### Running a Saved Query

1 Go to the upper right corner.

2 Click the drop-down arrow on the first field.

   Available saved queries appear in alphabetical order.

3 Click the name of the query you want.

### Deleting a Saved Query

1 Go to the application menu bar to select **Query>Delete Saved Query**.

   The **Delete Record** dialog appears.

2 Select the query that you want to delete.

3 Click **OK**.
Query Tips

♦ **Look for protocol-specific queries.** Some protocol teams define queries that are most useful to the members of that team. Look for protocol-specific queries in the *Queries* drop-down list in the top right corner of the window for each screen tab.

♦ **Use “*My Current” queries to locate current statuses.** In the *Queries* drop-down list, queries starting with “*My Current” will return lists with that status as the current status. Otherwise, querying on the *Status* field will return records that have ever included that status.

♦ **Use query operators to define your query.** Common database operators can be used to define your query (see “Query Operators” below).

Query Operators

Query operators can further define your query by enabling you to expand or restrict the search results. The table below defines some of the most common operators that you can use when running a query in the CTMS.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Guidelines</th>
</tr>
</thead>
<tbody>
<tr>
<td>* (asterisk)</td>
<td>Use before and/or after an entry to represent missing characters.</td>
</tr>
<tr>
<td>OR</td>
<td>Use to find various entries in a single field.</td>
</tr>
<tr>
<td>AND</td>
<td>Use to find multiple components in a single field.</td>
</tr>
<tr>
<td>&lt; &gt; =</td>
<td>Use to compare numbers in a field.</td>
</tr>
<tr>
<td>TODAY</td>
<td>Use in conjunction with &lt;, &gt;, and = operators to find entries in relation to the current date.</td>
</tr>
<tr>
<td>IS NULL</td>
<td>Use to find blank entries in a field.</td>
</tr>
<tr>
<td>IS NOT NULL</td>
<td>Use to find non-blank entries in a field.</td>
</tr>
</tbody>
</table>
Operator Scenarios and Examples

**NOTE:** Although the CTMS assumes an asterisk at the end of most entries—and assumes that entries used with operators are values—it is good practice to use an asterisk and / or quotes when running a query.

♦ To find all records where the PI’s last name contains “mi” (such as Miller, Mills, and Smith), in the **PI Last Name** field (on the **Site Management** screen tab), enter *

♦ To search for a list of sites in North Carolina, South Carolina, and Virginia, in the **Prov/State** field (on the **Site Management** screen tab), enter 'NC' OR 'SC' OR 'VA'.

♦ To search for a list of sites in the USA-Southeast and USA-Southwest regions, in the **Region** field (on the **Site Management** screen tab) enter 'USA' AND 'south'.

♦ To search for a list of sites that have enrolled more than ten subjects, in the **# Enrolled** field (on the **Site Management** screen tab), enter >10.

♦ To search for a list of sites for which the **Regulatory Complete** milestone date has not been recorded, in the **Reg Complete** field (on the **Site Management** screen tab), enter 'is null'.

♦ To find a list of site visits for January, 2009, in the **Planned Visit Start Date** field (on the **Site Visits** view tab), enter:

  > = 1/1/2009 AND < = 1/31/2009

♦ To find upcoming site visits (visits scheduled to occur after today), in the **Planned Visit Start Date** field (on the **Site Visits** view tab), enter:

  > TODAY()

  Notice the open/close parentheses at the end.

♦ You can find visits scheduled to occur after tomorrow by entering:

  > TODAY()+1

  This will increment one day for each day in the future after today.
The CTMS reporting tool enables you to generate standard CTMS reports that can be filtered for specific protocols, regions, and sites. At any time, you can also export a list of records to Excel for reporting purposes (see page 37).

**Standard CTMS Reports**

CTMS reports are generated using the Cognos application and are accessed via a CTMS viewer. Therefore, reports can be generated without leaving the CTMS application. To see samples of CTMS standard reports, go to the CTMS Learning Center (dcri.org > Education/Training > CTMS Learning Center), and then click Standard Report Samples, located under the Resources heading.

**Running a Report**

1. Click the Reports screen tab.
   A list of CTMS standard reports appears.

2. Click a blue hyperlink for the report that you want to run.

3. If a security message appears, click Yes.

4. When one or more filter windows appear in a new browser tab, select the appropriate options from each filter window. You can also click Select all to select all choices in a list or Deselect all to clear your selection and start over.
5 Do one of the following.
   ♦ If this is all the filtering you need, click **Finish**.
   ♦ If you need more filtering, click **Next** at the bottom.

6 Make your filtering selections.

7 Click **Finish** at the bottom.

What happens next depends on the file format for the report.

► **If the file format is Microsoft Excel**

A message appears over a blank screen as the system creates the report.

**Internet Explorer.** The system prompts you to either click open or close. To open right away, click **Open.** The file opens in Excel.

**Chrome.** The system sends the file to your computer’s **Downloads** folder. The file also appears at the bottom of the browser window. Click to open the file in Microsoft Excel.

**Firefox.** The first time you are prompted to specify which application to use. Select Microsoft Excel and click the checkbox to have the system default to Excel from now on.

**Safari.** The system sends the file to your computer’s **Downloads** folder. Open the folder (click ![folder icon]) to access the file.

Use standard Excel features to search, edit, save, print, or close.

► **If the file format is Adobe PDF**

Generally, the PDF opens in another browser window. Use the controls provided to search, edit, save, print, email, or close.
If the file format is HTML

The report opens in the browser tab. On a toolbar appearing at the top right, click the drop-down arrow on the HTML button.

To save as PDF:

1. Select **View in HTML Format**.
   The document opens in a new window.
2. Use the controls provided to search, edit, save, print, or close.

To save as Excel:

1. Select **View in Excel Options**.
   A flyout menu appears.
2. For most reports, select **View in Excel 2007 Format**. For reports formatted to group data, such as the Site Status and Milestones report, select **View in Excel 2007 Data** or **View in CSV Format**.
   A blank window opens with a message about the download at the top.

   **Internet Explorer**. The system prompts you to either click open or close. To open right away, click **Open**. The file opens in Excel.

   **Chrome**. The system sends the file to your computer’s **Downloads** folder. The file also appears at the bottom of the browser window. Click to open the file in Excel.

   **Firefox**. The first time you are prompted to specify which application to use. Select Microsoft Excel and click the checkbox to have the system default to Excel from now on.

   **Safari**. The system sends the file to your computer’s **Downloads** folder. Open the folder (click ![Open icon]) to access the file.

   Use standard Excel features to search, edit, save, print, or close.

**Emailing from CTMS:**

**WARNING**: When you email from the CTMS, there is no record of this sent message in your email account. Also, the recipient receives the message from “cscsupport@mc.duke.edu” instead of your name. For these reasons, we recommend you send an email from the CTMS to your own email account—then forward it to other recipients from your email account to save a copy to your Sent view for your records.
On the toolbar, click the drop-down arrow at Keep this version. A drop-down list appears.

Select Email Report. An email window opens in the CTMS.

If your email address does not appear in the To field, add it.

(optional) Edit text in the Subject field and enter text in the Body area.

Click OK. An HTML version of the report is attached to an email message in your Outlook inbox. Use Outlook to forward the report to recipients. Save a copy of the message to your Sent view for your records.

Returning to CTMS after Running a Report

Close the browser tab or window when you are done with the report. The Reports screen tab still appears in the original browser tab or window. You are free to continue opening other reports or to click a different screen tab.
Exporting Data to Microsoft Excel

Any list of data in the CTMS can be exported to Excel for further formatting, editing, printing, or saving. You can only export data from a list (not from a form view).

**Tip:** To limit the number of records that are exported to Excel, select specific rows by holding the Ctrl or Shift key while clicking on the rows that you want to export. The Ctrl key enables you to select non-consecutive rows, while the Shift key enables you to select a group of consecutive rows.

1. In the application menu bar, select **File > Export Data Map**.

   The Export window opens.

2. Set the rows and columns you want to export, leave the **Output Format** to either Tab Delimited Text File or Comma Separated Text File, and then click **Next**.

   **Note:** If you want, you can set the **Output Format** field to export the information into an HTML file that opens in your default browser, or a text file that opens in Notepad.
Internet Explorer. The system prompts you to either click open or close. To open right away, click **Open**. The file opens in Excel.

Chrome. The system sends the file to your computer’s **Downloads** folder. The file also appears at the bottom of the browser window. Click to open the file in Excel.

Firefox. The first time you are prompted to specify which application to use. Select Microsoft Excel and click the checkbox to have the system default to Excel from now on.

Safari. The system sends the file to your computer’s **Downloads** folder. Open the folder (click ![Folder Icon]) to access the file.

Use standard Excel features to search, edit, save, print, or close.
APPENDIX A: ENABLE POP-UP WINDOWS IN CHROME

By default, Google Chrome’s pop-up blocker setting prevents attachments from being opened from within the CTMS. To enable pop-up windows to open, you must disable the pop-up blocker while your browser is on this website. You only need to do this once.

The procedures listed below are specifically for Google Chrome Version 54. Adjust, as needed, if you use a different release of Chrome.

Changing Chrome’s Pop-Up Blocker Setting

1. Click the “customize” icon to the far right of the URL field.

2. Select Settings.
   Browser settings appear.

3. In the Search field, query on pop-up.

4. Click Content settings.

   The Content settings dialog appears.

5. Scroll down to the Pop-ups section, and then click Manage exceptions.
The Pop-up exceptions dialog opens.

6 Enter `https://[*]duke.edu` in the blank **Hostname pattern** field (keep **Allow** as the **Behavior**).

![Pop-up exceptions dialog](image)

7 Click **Done**.

The Pop-up exceptions dialog closes.

8 On the **Content settings** dialog, click **Done**.

The Content settings dialog closes.

9 You can close the browser tab with Chrome’s settings.
APPENDIX B: CTMS ACCESS FORM

Use the CTMS Access Form to request access to the CTMS for in-house and remote employees. The form must be completed by the Project Leader, Senior Lead CRA, or Lead CRA, and then submitted by email to the DCRI Service Desk (dcriservicedesk@dm.duke.edu). You will be notified when access has been granted.

To access this form on the CTMS Learning Center:

1  In the address bar, enter the URL:

   https://dcri.org/education-training/ctms-learning-center

2  Press Enter.

3  Click CTMS Access Form under Forms and Instructions.